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Use Excel’s functions!

* A function is a predefined (built-in) formula for
commonly used calculations.

e Each Excel function has a name and syntax.

— The syntax specifies the order in which you must
enter the different parts of the function and the
location in which you must insert commas,
parentheses, and other punctuation

— Arguments are numbers, text, or cell references
used by the function to calculate a value

— Some arguments are optional

&‘ 101 1/28/2009 Microsoft Excel




Functions

* Excel supplies more than 350 functions
organized into 10 categories:

— Database, Date and Time, Engineering, Financial,
Information, Logical, Lookup, Math, Text and Data,
and Statistical functions

 You can use the Insert Function button on the
Formula bar to select from a list of functions.

* Aseries of dialog boxes will assist you in filling in
the arguments of the function and this process
also enforces the use of proper syntax.
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f, marks the spot!

e Office Excel 2007 offers two methods to insert
predefined functions into your spreadsheet ....

— The first method is the use of the Function Button
next to the Formula Bar:

Function Button Formula Bar
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f, marks the spot! (cont)

— The second method is the use of the Formulas tab
and the Function Library:

EF . H -
-

- Home Insert Page Layout Formulas Data Revi
ft ¥ AutoSum - ﬁ' Lagical = E_:L Lookup & Reference =
[ Recently Used ~ [A Text - & Math & Trig -

Insert - - s
Function LI-T_;' Financial = EE;' Date & Time - l[,]'__j More Functions -
A

I Fum:tiT‘u Library I

Insert “Function Window”
(like the Function Button)

Specific Group Types of Functions
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Inserting a Function

Categories

Available
Functions
within
Category

Insert Function

Search for a funckion:

Type a brief description of what wou want to do and then click

G0

Or select a cateqory:

Select a function:

IF

RANE

= SLM
HYPERLIME
COLUMT
Ma,

AYERAGE(number1

Most Recently Used

all

Financial
Dake & Timne
Math 2 Trig
Statiskical <z

Lookup & Reference
Database

Texk

Logical

Information

Returns the average

Engineering

W

b be numbers or

names, arrays, or references that contain numbers,

Help an khis Function

|

Ok

][ Cancel ]

Available
Function
Categories

The Insert Function Window is identical to that of previous
versions of Excel. If you aren’t familiar with this window, the
functions are grouped into categories and listed accordingly.
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Tips on Functions

* The Search for a Function (from the Insert Function
Window) will attempt to locate the function based upon a
description of what you would like to do.

* You may also select a category from the drop-down box, or
choose All (lists every function in Excel alphabetically).

* Things to remember about functions:
— The arguments shown in boldfaced type are required

— When the cursor is in an argument's text box, you can
either enter a value, a cell reference, or click on a cell
(cell pointing)
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Functions from the Formulas tab
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2 AutoSum T ﬁ Logical = fu__}f Lookup & Reference -
[ Recently Used = [A Text - @ Math & Trig -
ﬁ__l-'? Financial = EE, Date & Time - ﬁ.J More Functions =

The ribbon list (Functions Library) from within the
Formulas tab are categorized the same as the groupings
from the Insert Function Window (previous example).
The key to using the categories is to DERIVE what the
commonality of the groupings is.

Red Hot Tip -> practice using the functions as if you were
practicing with a musical instrument! That way your
thought process is automatic and not “search and pray.”
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Functions YOU should know

Statistical Functions

MAX - find the greatest value in a range

MIN — find the lowest value in a range

* AVERAGE - determine the average within a

{- 101

range (sum divided by number of values)

COUNT — determines the number of cells in a
range containing a numeric value (counts them)

COUNTA = counts the cells with text as well as
numeric values (non blank cells)
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Functions YOU should know (cont)

Arithmetic Functions

* SUM - adds (sums) all values in a range

{the Sigma button, AutoSum, is also this function}

e ROUND - rounds a decimal number to a
specified set of digits
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Functions YOU should know (cont)

Logical Functions

* |F —a decision making function used to
determine the truth value for a condition

 AND — determines the truth value for a group of
arguments as a whole (all must be true to be
true)

* OR —determines the truth value for a group of
arguments separately (only one must be true)
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Functions YOU should know (cont)

Financial Functions

* PMT - calculates the payment for a loan based
on constant payments and constant interest rate

 FV —determines the future value of an
investment based on periodic, constant
payments and a constant interest rate
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Functions YOU should know (cont)

Lookup Function

* VLOOKUP —searches for a value in the first

column of a table array (cell range) and returns
a value in the same row from another column in
the table array.

* The Vin VLOOKUP stands for vertical, meaning
that the value to “lookup” is searched for in a
vertical manner!
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Commonly used functions syntax

AVERAGE(number1, [number2, number3, ...])  Calculates the average of a collection of numbers, where

number1, number2, and so forth are numeric values or
cell references

COUNT(valuel, [value2, value3, ...])) Calculates the total number of values, where valueT,
value2, and so forth are numeric values, text entries, or
cell references

MAX(numberl, [number2, number3, ...]) Calculates the maximum of a collection of numbers, where
number1, number2, and so forth are either numeric values
or cell references

MEDIAN(number1, [number2, numberd3, ...]) Calculates the median, or the number in the middle, of a
collection of numbers, where number1, number2, and so
forth are either numeric values or cell references

MIN(number1, [number2, number3, ...]) Calculates the minimum of a collection of numbers, where
number1, number2, and so forth are either numeric values
or cell references

ROUND(number, num_digits) Rounds a number to a specified number of digits, where
number is the number you want to round and num_digits
specifies the number of digits to which you want to round
the number

SUM(number1, [number2, number3, ...]) Calculates the sum of a collection of numbers, where
number1, number2, and so forth are either numeric values
or cell references

-~
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In-class Example — common functions

Sample spreadsheet with common functions
(Stocks.xlsx).

(you will find this file on my lecture notes page)
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In-class Example — VLOOKUP function

Sample spreadsheet with VLOOKUP function
(Baseball Shutouts.xlsx).

(you will find this file on my lecture notes page)
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Sorting data in a worksheet

e Why Sort?
— Easier to read a data list that has been sorted
— Can aid in proof reading for data entry errors
— Things like “people” lists are easier to maintain

* Excel makes it easy to sort a list in ascending or
descending order based on any field(s) in the list.

* The field(s) selected to sort on are called the sort
fields or the sort keys.

17
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Sorting a worksheet

LU LUCENT TECHNOLOGIES
Do the Two Step: AV AVAYA INC.
MOT MOTOROLA
o Step 1 —select data in MYL MYLAN LABORATORIES

CSCo CISCO CORP. (NAS)
worksheet to be sorted CMCSA COMCAST CORPORATION

INTC INTEL CORPORATION
e Step 2 — From the Data
tab, select either:

ascendingwﬂwiew View Add-Ins
INNE . ]_7 i+ Clea

|

or descendin - BE
Z| sort | Filt ' '
il so e ‘W2 Advanced
ions Sart & Filter

r LY
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Sorting using a single sort key

Initial Present Humber of Present Market Initial Market
Symbol Company Cost Cost Shares Value Value
ABT ABBOTT LABS 43.2 45.3 500 22 650.00 21,600.00
AEP AMER ELECTRIC POWER 34.4 34.4 400 13,760.00 13,760.00
AMU APRILIA USA 67.11 58.96 1700 100,232.00 114,087.00
AV AVAYA INC. 15.9 16.02 500 8,010.00 7,850.00
BHI BURLINGTOMN M. S.F. 40.1 441 1800 78,380.00 T72180.00
ER BURLINGTON RESOURCES #.53 40,47 2200 29,034.00 91,366.00
CLX CLOROX CORP 55 55.85 1250 69,812.50 68,750.00
CMCSA COMCAST CORPORATION 19.61 29.61 700 20,727.00 13,727.00
C5C0 CISCO CORP. {HAS) 18.5 18.74 4800 89,952.00 2a,800.00
DD DUPONT 43.44 43.44 2100 891,224.00 91,224.00
DIs VWALT DISNEY 26.4 26.59 600 15,954.00 15,840.00
G GILLETTE 43.01 43.99 7800 34312200 335478.00
GE GENERAL ELECTRIC 35.79 35.8 2100 75,180.00 75,159.00
HHZ HEINZ, H. . 38.4 J8.41 3200 122,912.00 122,880.00

Data sorted alphabetically by Symbol.

LY
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Multiple key sorting

|

-— —
B
= B

BN MR

4] Add Level | X Delete Level | | =3 Copy Level | | i | Options...
Column Sort On Order
Sortby | cColumnB w | |Values w | |AtoZ
Then by w | |Values w | |AtoZ

[] My data has headers

. Pressing this button ....

Sort will give you this dialog window for
setting-up multiple levels of sorting.

Ok

l ’ Cancel
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A word of caution ....

 When sorting a data table in a worksheet ....
be sure to select all data in the worksheet
before sorting.

Do you know why?
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In-class Example

Sample sorting worksheet (Stocks _to Sort.xlIsx)

(you will find this file on my lecture notes page)
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AutoFilter feature

* Filtering is a quick and easy
way to find and work with a - .
subset of data in a range. Al A 02 Advanced

A filtered range displays sort & Filter
only the rows that meet the
criteria you specify for a

lf 7.

o B

column. * Select the Filter option,
* Unlike sorting, filtering does from the Sort & Filter
not rearrange a range - ribbon in the Data tab.

filtering temporarily hides
rows you do not want
displayed.
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Autofiltering

A B C D 2] sotatoz
1 LastMame = First Nam » Status | = [Rank > Z| sortztoA
2 Holmes Sarah S FR o "o
3 | Littleton Rachel EL JR Sort by Color '
4 Rada Alexander MR =R
5 Howell Donna EL =0 ,
B Haines Heidi EL FR
7 Drawhbaugh Mark MNE MK, Text Filters g
B See ."':'".m'_'g.-" EL ol |:5E|EE1I .l5.||:l
5 Fincham Tiffany LIE. =R W FR
10 Salzmann Ashley EL JR | R
[ MEC
W50
. [¥] SR
Clicking on the “drop-down arrow” ] (Blanks)
for a column ....
. . . . . . oK Cancel
will display the filtering options window. | [ conee

n
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Autofiltering (cont)

: : 4] sortAtoz FR
* By using Text Filters, - "
you cah specify a Sort by Color > 5o
FR
condition [to filter data N
Text Filters * Equals...
by] that would normally o e Ea.
take a great deal of time o Begins With.
] 5W Ends With...
when you use the ?é‘[‘ ) contais..
an .
simple sort/remove i
method! T
MIE.
oK ] ’ Cancel SR
SIFR

F n
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Using Auto Fill

 To use the Auto Fill feature, select the cell
[range] that contains the values and/or formulas
you want to copy.

* Click and drag the fill handle in the direction you
want to copy and then release the mouse
button.

* |f needed, click the Auto Fill Options button, and
then select the Auto Fill option you want to
apply to the selected range.
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An example of Auto Fill

A B A B A B C D
1 1 1 1 L !
2 2
2 2 2 2 3 3
3 3 3 3 4 4
4 A 4 4 3 3
) )
5 5 5 - :
g v] ] 2 8
7 ) Fi 3 3
10 10
8 ¢ € 11 11
5 g E 12 12|
10 10 1EI'_ 13 =
11 11 E:IA 14 () Copy Cells
12 12 12 s Fill Series
17 (' Fill Eormatting Only
18 () Fill Without Formatting
. . 19
Fill Handle Pointer

Auto Fill Options Button
Options!

LY
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Auto Fill Options button menu options

* Copy Cells will copy all values and formulas into
the selected range as well as the formats used
to display those values and formulas.

* Fill Series does just that! What are the rules?

* Fill Formatting Only copies only the formats
used to display values or formulas without
copying the values and formulas themselves.

* Fill Without Formatting copies only the values

and formulas without any of the formats used in
the source range.
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Questions?
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